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Integration Overview 
Thomson Reuters offers a cloud-based integration of ONESOURCE Determination with SAP 
Business One for Canada Federal and Provincial Goods and Services Tax (GST). ONESOURCE 
Determination integrates with SAP Business One through the SAP Business One Service Layer, an 
integration application that exposes Business One data and services, maps ONESOURCE 
Determination fields to the SAP Business One fields and returns the Calculated Tax amounts and 
rates. 

This integration will support the following events from SAP Business One. 

• Estimate Tax Calculation Calls for Sales Quotations, Sales Orders, Purchase Quotations and 
Purchase Orders 

• Audited Tax Calculation Calls for Accounts Receivable Invoices and Cancellation of A/R 
Invoices, A/P Invoices and Cancellation of A/P Invoices 

• Estimate and Audited Tax Calls for Sales Returns or A/R Credit Memos, Purchase Returns 
or A/P Credit Memos 

ONESOURCE Indirect Tax Determination using the REST API for SAP Business One is supported 
for the SAP SQL Version. These extensions would work for both the on-premise environment and 
cloud cluster. In addition, with this release, HANA DB compatibility is now supported.  

Prerequisites 

This integration is supported for SAP Business One (SQL) version 10.0 or higher for both On Cloud 
and On-Premise deployments. In addition, HANA DB compatibility is now supported.  

 
For a successful implementation of the integration with SAP Business One, please ensure you have 
procured the necessary packages and followed the implementation steps outlined below: 
 

Platform Component Description 

SAP Business One Local and Cloud 
environment 

• Add and activate the Thomson Reuters SAP Business 
One extensions to the system setup. 

• Build and update the system with Canada localization 
settings to activate the extensions. 

• Maintain relevant system configuration for various 
integration options including connection details and 
authentication options. 

ONESOURCE 
Determination 

Cloud 
Environment 

• Set up of the External Company ID that uniquely 
identifies the tax request within the ONESOURCE 
Determination solution for audit, reporting, and 
returns purposes. 



 

• OAuth2 authentication details are required to set up 
the integration. 

 

Architecture and Design Overview 

 

The Thomson Reuters ONESOURCE Determination Integration with SAP Business One uses the 
Service Layer to seamlessly connect to the Indirect Tax Calculation REST API.  

This extension or add-on needs to be added to your setup to trigger and manage the tax calculation 
calls.  

To support this integration, you will need to have some additional fields on your marketing 
documents in SAP B1. These fields provide extra information needed for the tax breakdown. 

To display the calculated taxes from ONESOURCE Determination, this integration utilizes the 
Freight Setup functionality within SAP Business One to define the various levels of authorities. 
 
For security purposes, authentication and client credentials will be verified with every tax call. Your 
credentials are securely stored under the company setup. 
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Known Limitations 

• ONESOURCE Indirect Tax Determination using the REST API for SAP Business One is only 
supported for the SAP SQL Version. These extensions would work for both the on-premise 
environment and cloud cluster.  In this release, HANA DB compatibility is not supported.  

• The tax integration supports only one delivery addresses per document. Taxes will be 
determined based on this address. 

• The Summarization feature is not yet available for this release.  

• Batch processing of invoices for both sales and purchase processes are not supported. 

Business Process Description 
Order to Cash Process  

Here the tax determination within SAP Business ONE is supported right from the quotation 
transaction. The quote will call ONESOURCE Indirect Tax Determination for tax calculation but will 
not record the tax liability (commit the transaction). After the quote is converted into an order, 
ONESOURCE Indirect Tax Determination will again be called to update the tax amount as it could 
change due to factors such as dates, pricing, quantities etc.  
 
Depending on the tax jurisdiction, shipping costs that are added in the sales order could be a taxable 
or non-taxable event. After the shipping process, an invoice is generated and ONESOURCE Indirect 
Tax is called again for a final update of the taxes. Once the final invoice is created, ONESOURCE 
Indirect Tax Determination is updated by a final commit tax call with the tax liability stored for future 
reporting and returns processing.  
 
A Correlation ID is generated for each document, which can be used for audit, tracking and 
reconciliation purposes. 
 

The business processes covered by this integration are:  

• Sales Quotes  

• Sales Orders  

• Sales Invoices  

• Credit Memos  

• Invoice Void/Cancellations   

Procure to Pay Process  

Similar to the Order to Cash process, tax determination within SAP Business ONE is supported right 
from the purchase quotation to AP invoice transaction. The quote will call ONESOURCE Indirect Tax 
Determination for tax calculation but will not record the tax liability (commit the transaction). After the 
quote is converted into a purchase order, ONESOURCE Indirect Tax Determination will again be 
called to update the tax amount as it could change due to differences in dates, pricing, quantities etc.  



 

 
As well, depending on the tax jurisdiction, shipping costs that are added in the purchase order could 
be a taxable or non-taxable item. After the shipping process, a purchase invoice is generated and 
ONESOURCE Indirect Tax is called again for a final update of the taxes. Once the final invoice is 
created, ONESOURCE Indirect Tax Determination is updated by a final commit tax call with the tax 
liability stored for future reporting and returns processing.  
 
A Correlation ID is generated for each document, which can be used for audit, tracking and 
reconciliation purposes. 
 
Within the purchase invoice, this solution also integrates with the ONESOURCE Determination 
Vendor Charge Tax Verification (VCT-V) functionality for PST Provinces. This feature automates the 
decision-making process to support and handle differences between ONESOURCE Determination 
calculated tax and the vendor charged tax by using the ONESOURCE Determination VCT-V 
functionality for vendor invoices. 
 
In this solution, we are not using the default SAP Tax engine to calculate taxes. Instead, an "N/A" tax 
code with a 0% rate will be applied by the tax determination process. Since the default functionality 
does not calculate the tax amount, it will not be included in the stock during a purchase invoice (if 
user wants to evaluate the tax amount to the stock). 
 
To ensure compliance with statutory requirements, we use a Landed Cost transaction to allocate the 
tax amount to the stock. After posting an Accounts Payable (AP) invoice, a landed cost document 
will be automatically created to offset the purchase tax clearing account. 
 
By using this approach, we ensure that the correct tax amount is accounted for while meeting the 
necessary legal regulations. 
 
 
The business processes covered by this integration are:  

• Purchase Quotes  

• Purchase Orders  

• Purchase Invoicing  

• Purchase Credit Memos  

• Invoice Void/Cancellations   

How does the integration work? 

Display of Tax Authority Levels 

In Canada, each taxation authority imposes tax based on jurisdictions. After taxes are determined for 
each authority from ONESOURCE Indirect Tax, it gets assigned to relevant tax authority levels in 
Business One. In this integration we have mapped the following tax authority levels based on the 
effective zone levels as follows:  
 
 
 
 
 



 

Business One Tax Authority Level Effective Zone 
TR_GSTTax GST  

TR_HSTTax HST  

TR_PSTTax   PST  

TR_QSTTax QST  
 
This integration utilizes the Freight Setup functionality within SAP Business One to define the 
various levels of tax authorities determined from ONESOURCE Determination. 
 
To access Freight Setup: In SAP Business One, navigate to Administration > Setup > Financials 
> Freight Setup. The various breakdown of the taxes will be set up automatically when you import 
the extension. 
 
 

 

Tax Code Usage and Tax Liable Indicator 

• With this solution, you are no longer required to set up tax codes as the SAP default Tax 
engine is not used. A default tax code of “N/A” will be created automatically during the 
installation process.  

• Additionally on the item level, you can indicate if the taxes are liable or not by selecting “Yes 
or “No” under the “Tax Liable” column. We recommend to always indicate the line item as 
Tax Liable and have ONESOURCE determine the taxability status of the item instead. 

Freight - Setup

# Name Revenue Account Expense Account Fixed Amount - Revenues

FREIGHT 41400000 65500000
2 Handelling Charges 41400000 65500000
3 Other Charges 41400000 65500000
4 TR_GST 24100000 24110000

5 TR_HST 24600000 24610000
6 TR_OverCharge
7 TR_PST 24280000 24280000
8 TR_QST 24280000 ÿ

9 TR_TaxAccure ÿ

10 TR_XAdjustC ÿ

11 TR_XAdjustD 24710000

3

OK

 

     

   

    

    

    

    

  

    

    

   

   

   

 



 

 

 

Sales Quotation

Customer 10000 No. Primary 25
Name envolkan@gmail.com | Engin Vd Status Open
Contact Person Posting Date 09/23/22
Customer Ref. No.Commerce_US_Shipping_Return Valid Until 10/23/22
Local Currency Document Date09/23/22

Contents Logistics Accounting Attachments

Item/Service TypeItem Summary TypeNo Summary
Item No. Item Description QuantityUnit Price Discount % Tax CodeTotal (LC)Whse Tax Liablereight 1Freight 1 (LC)Distribute Freight Distrib. Amount (LC)UoM CodeUoM NameCountry/Region ...
> 12 Item No1 With Product code 5 $ 34.00 0.000NA $ 170.008Mÿ sa Yes Manual EACH USA

00102 Item No1 With Product Code 5 $ 7.50 0.000>NA $ 37.50 > W8Tes Yes ÿ Manual EACH USA
0.000

Sales EmployeeNo Sales Employee-ÿ Total Before Discount $ 207.50
Owner Discount
Tax Amount

%
14.03 Sales Tax & Freight E01$

Rounding
xe1
 Total 25'122$

Remarks ok

OK Add Draft & NewCancel Calculate Tax Copy From Copy To

 

     
    

   
    
  

    
    

            
             

             
 

  
   

  
 

 
   

 
 

 
  

     



 

 
 

• After entering all the details of the document, such as customer, date, reference, items 
details, unit price, quantity, discount (line and document level), warehouse (ship from 
location), and the ship to location, the user is required to click on the “Calculate” button to 
check and see the tax amount for the transaction. 

• If any changes occur after calculating the tax and you attempt to save the transaction without 
recalculating, the system will automatically trigger the recalculation and apply the correct tax 
amount. 

• Once all necessary information is entered and the system calculates the tax based on the 
address and jurisdiction, the tax amount will be displayed in the freight table, as shown in the 
image below. This window provides an overview of freight charges, other fees, and 
jurisdiction-specific tax details for final posting. 

 

Form Settings - Sales Order

Select UI Template Apply

Table Format Row Format Document

Find Next

Column Visible Active
Ordered Qty in Whse
Standard Item Identification ? ?

Commodity Classification
GST Rate

GST Amount
PST Rate
PST Amount
HST Rate
HST Amount
QST Rate
QST Amount
Freight GST Rate
Freight GST Amount
Freight PST Rate
Freight PST Amount
Freight HST Rate
Freight HST Amount
Product Code

Freight QST Rate ? ?

Cancel Restore Default

 

  

   

 
   

 
   
 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 

   

 



 

 
 

• If charges have no distribution method, the total tax amount and consolidated tax rate will be 
displayed in the Tax Rate and Tax Amount fields, while the Net Amount field will show the 
overall total. 

• This solution supports Vendor Charged Tax (VCT) functionality during the purchase process, 
with different accrual methods available depending on VCT configuration. If accrue tax is 
identified, the "TR_AccrueVariance" line item in the freight setup will be used to capture the 
accrual amount. This line item is applicable only if accrual methods are set to Accrue 
Variance or Accrue Total Tax in ONESOURCE Determination. 

• If the accrual method is HOLD PAYMENT, the system will prevent posting the transaction 
until the user modifies the details or the system receives another accrual method. In such 
cases, users can save the document as a draft and later finalize it. 

• If the accrual method is Pay_VCT_No_Accrual, the system will include the VCT (-) 
Calculated Tax variance amount in a separate line item called "TR_Other," which will also be 
considered in landed cost calculations. Regardless of the tax charged by the supplier, the 
same amount will be paid to the supplier in this scenario. 

 

Installation and Set Up 
Importing an Extension 

• Download the SAP Business One TR Indirect Tax Extension (Add-on) from the shared linked 
by THOMSON REUTERS. You need to have a valid subscription of the solution. 

• Log in to SAP Business One Extension Manager, go to Administration> Add-ons> Add-on 
Administration and then click on Extensions > Import. 

• The Extension Import Wizard window appears. Choose the Browse button to locate the zip 
file of your extension and choose Upload. Follow the prompts to complete the setup. 

Sales Tax & Freight

Do Not Display Freight Charges with Zero Amount

# Freight Name Remarks Total Tax Amount Distrib. Method Net Amount Status

1 FREIGHT $0.00 None $ 0.00 O

2 Handelling Charges $0.00 None $0.00 0

m Other Charges $0.00 None $0.00 0
4 TR_GST $ 0.00 None $0.00 O

5 TR_HST N/A 000$ None $260.00 0

6 TR_OverCharge $ 0.00 None $0.00 0
7 TR_PST $0.00 None $0.00 0

$0.00 None ÿ 0

6 TR_TaxAccure $0.00 None ÿ D

10 TR_XAdjustC $0.00 None ÿ $0.00 O

TR_XAdjustD $ 0.00 None ÿ $0.00 O

$260.00

OK Cancel

 

 

       

      

      

      

      

       

      

      
    

      

       
      

 

 



 

 

Assigning an Extension to a Company 

• After performing the import, go to the Company Assignment tab. From the company list, 
select the company to which you want to assign the extension. Choose Assign to complete 
the setup. 

 

Specify Startup Mode  

This is an on-time activity to default the Extension Startup Mode or to change a startup mode for a 
specific user.  
 
 To automatically run the extension for all transactions, from the Specify Setup Mode tab, select the 
default startup mode of this extension and specify the user preferences, and choose Next. 
 
We recommend that you set the default startup mode to Mandatory, so that the extension starts 
automatically to enable all transactions created within SAP Business One to apply the 
ONESOURCE Indirect Tax Determination application. 
 

SAP SAPBusiness One Extension Manager Welcome B1SiteUserSystem Landscape DirectoryHelp

Extensions Company Assignment Security Setings ServerB1APPSYS

Import Remove

Name Type Version Provider Parameters Force
Install Status More Info

TRIndirect TaxSolutions LightAddOn 1.0.0 Thomson Reuters Edit OK Details
TR Indirect Tax Utility OK

Extension Import Wizard
Details

TRIndirect TaxUtiity CA OK Details

Upload TR Indirect Tax Utilty CA.zipBrowse Upload

Specify Shared Parameters

Finish

SAP SAPBusinessOneExtension Manager Welcome B1SiteUserSystem Landscape DirectoryHelp

Extensions CompanyAssignment Security Settings Server

CompanyList Database Name TRUS CompanyName TRUS Version 1000180

TRUS

Extensions

Assign Unassign
Name Type Version Provider Enabled Settings Status

TRIndirect TaxUtility LightAddOn 1.0.1 Thomson
Reuters ÿ Edit OK

     

     

  

      
   

       
  

 
 

   

   

 

    

    

       

 

 
  

      

    
   



 

 

Running the Extension in SAP Business One 

After you assign the extension to a company, the SAP Business One client will automatically load 
the extension the next time you log o to the company. If you have set the startup mode to 
Automatic, you now need to manually start the extension each time you log in. 

From the SAP Business One Main Menu, choose Administration> Add-Ons> Add-On Manager. 
Select the extension and click on Start.  

The SAP Business One client will start the system configuration and create the required fields and 
tables. 

 

Connecting SAP Business One to ONESOURCE Determination 

This section outlines the configuration steps required as an initial set up to connect your SAP 
Business One client to ONESOURCE Determination. 

Company Setup 

Fille Edit View DataGo To ModulesToolsWindowHelp TRTEST|manager

-Choose Company
-Web Client

Exchange Rates and Indexes

SystemInitialization Add-On Manager ÿ

Setup netalled Ad-Ons
Data Import/Export Add-On tD Parther Name Add-On Name

utilities 8711 Thomson Reuters

Approval Process

Integration Service
Add-Ons

Add-OnManager
Mobile Add-On

Workflow

-Alerts Management
Financials
CRM

Sop
Opportunities
Sales-A/R
Purchasing-A/P

BusinessPartners

Extension AssignmentSettings

Parameters DefaultStartupMode Mandatory

Startup Mode

UserPreferences

UserName StartupMode

manager Default

B1i Default

Workflow Default

Support Default

AlertSvc Default

EDsUser Default

        

 
 

 

 
 

 
  

    
 

  

 

 

 
 

 

 
 

 

  
 

 

 

 

   

 

 

  

  

  

  

  

  

 



 

A custom TR menu is now available to carry out the relevant configurations for this integration. From 
the Main Menu, go to Administration> Setup> TR Configuration. 
 

 
 
Fill in the required information as follows: 
 

Field Description 

Company Name 

The company name and 
corresponding branches will be 
automatically loaded.  

TR Internal ID 

This is the External Company ID 
within ONESOURCE 
Determination that uniquely 
identifies your company for its 
rules, rates, and other processing 
logic to be applied.  

TR Client ID 

This is the client id required for 
OAuth2 authentication of the tax 
calls. Obtain this information from 
your Professional Services team. 
 

Secret ID 

This is the client secret Id required 
for OAuth2 authentication of the 
tax calls. Obtain this information 
from your Professional Services 
team.  

 

File Edit View Data Go To Modules Iools Window Help

Administration Choose Company
Web Client

Main Menu 1 ÿ

e System Initialization
TRTEST
manager Sales - A/R General

Mgdules Drag & Relate Purchasing - A/P Data Import/Export Financials

Administration 8 Business Partners Utilities Opportunities

ÿ Banking Approval Process Sales 1

Financials
8 Inventory Purchasing

CRM Resources Integration Service Business Partners

e Opportunities Add-Ons Bankingÿ
1

Sales - A/R Workflow
ÿ Service Alerts Management

Purchasing - A/P
Human Resources Service

00 Business Partners Reports Production
ÿ Banking
8 Inventory

   

  
 

  

 

  
 

   

     

     
    

 
 

   
    

     
 

  
   

   
    
  

 



 

 
 

Maintaining ONESOURCE Determination URL  

Go to the Other Settings tab and enter the Determination URL as 
provided by Thomson Reuters. This is a one-time set up.  

 
 

TR Configuration X

Company Info Header Attribute Line Attribute Other Settings
Company Name TR Internal ID TR Client ID Secret ID
SAP DEV US Business OneINTSAPDEV_USBusinessOnejW65Er5NjzYPW4qw1DA0vcpEEjeeZ4EHVDmG3rpkxvJ0684y

OK Cancel

 

  

    

    
    

 



 

 

Functional Configuration 
General Ledger Set Up 

To define the General Ledger (G/L) accounts for the various tax levels in the integration. By defining 
the G/L accounts for each tax level in the Document Settings, you ensure that the integration 
correctly handles the posting of taxes to the respective G/L accounts based on the determined tax 
jurisdictions. 
 
From the SAP Business One Main Menu, navigate to Administration > System Initializations > 
Document Settings. 
 

 
 

File P3 View Data GoTo Modules Tools Window Help TRTESTmanager
Administration Choose CompanyX ÿ
Financials

ÿ CRM Exchange Rates and Indexes Look upmaster data and documents
ÿ Opportunities System Initialization

Financials R Sales-A/R General Settings

CRM ÿ Purchasing-A/P Posting Periods
ÿ Business Partners Authorizations

Opportunities ? Banking Approval Process Document Numbering
PSales-A/R License Document Settings

Resources Integration Service
ÿ Purchasing-A/P “ÿ Add-Ons
ÿ Business Partners ÿ Workflow

ÿ Service Alerts Management E-Mail Settings
? R Human Resources Opening Balances

Inventory ÿ Reports Implementation Center

ÿ Resources

nod.

MRP

Service

Reports

TR Configuration

Company Info Header Attribute Line Attribute Other Settings

Product Code Item Group

URL https://api-cloud-sat.onesourcet.
Post Landed Cost

Update Cancel

         

    
 

    
   

    
 

   
   

     
    

  
    

    
        

    

  

 

 
 

 

    

  

  

 

 



 

Scroll down and locate the "Freight Setup" section. Click on Freight – Setup button. 

 
 
Within the Freight Setup section, you will find options to define the G/L accounts for different tax 
levels or jurisdictions. 
 

 
 
This section provides guidance to assign the appropriate G/L for the following processes. These are 
only recommended G/L account set up, please work with your G/L accountant to define the correct 
accounts for your company. 
   

G/L setup for Sales Process 

Maintain the appropriate G/L account under the Revenue Account setup for each authority level.  
 
For Canada, the following authority levels are defined. 

Document Settings
Per Document  Electronic Documents

Calculate Gross Profit
 Base Price Origin Item Cost
Default Gross Profit % for Service Documents0.000

Calculate % Gross Profit as!
O Profit/Sales Price O Profit/Base Price

Document Remarks Include!
Jaqwnn quawnog aseg  Manual Remarks Only  BP Reference Number

For a Sales BOM in Documents, Displayi
 Price and Total for Parent Item Only.O Price for Component Items

Response to G/L Account Balance Outside Allowed Range!
O Without Warning O Warning Only  Block Posting

Response to Release / Receipt of Inventory Outside Defined Range
O Without Warning O Warning Only O Block Release / Receipt

Block Negative Inventory By Item Setting
Rounding Method

O By Currency
OBy Document

Exchange Rate Base Date (A/P Documents) Posting Date
Split Journal Entry Posting by Document Lines No Split

 Display Rounding Remark
Use Warehouse Address
Manage Freight in Documents Freight - Setup

 Block documents with earlier Posting Date
 Allow Future Posting Date
 Use Document Exchange Rate When Copying to Target Document
Attachments
 Copy Attachments from Base Document to Target Document
 Copy Attachments from BOM to Production Order
 Do Not Overwrite Attachments with the Same File Name

 Manage Inventory by Warehouse

 Display Canceled and Cancelation Marketing Documents in Reports
Max. No. of Days for Canceling Marketing Documents Before or After Posting365

Blanket Agreements
 Block Multiple Blanket Agreements for Same A/P Document 
 Block Multiple Blanket Agreements for Same A/R Document 

Freight - Setup

Name Revenue Account Expense Account Fixed Amount - Revenues

1 FREIGHT 41400000 65500000
2 Handelling Charges 41400000 65500000

3 Other Charges 41400000 65500000
4 TR_GST +

5 TR_HST ÿ 2

6 TR_OverCharge ÿ

7 TR_PST 24280000 24480000

8 TR_QST 24280000 2 24480000

TR_TaxAccure 25150000
10 TR_XAdjustC + 15200000

TR_XAdjustD 15200000

12

3

OK

 

  
 

 
  

 
  

 
  

 
  

 
   

 
   

  
 

 
 

  
  

 
 

  
 

 
 

 
 

 
 

 

 
  

 

 

    

    

    

    

   

  
  

   

    

     

  

    
  

 

 



 

 
 
 

Tax Account Description 
TR_GST G/L account where the city authority tax amount will be posted to under 

the Revenue Account setup. 

TR_HST G/L account where the county authority tax amount will be posted to 
under the Revenue Account setup. 

TR_PST G/L account where the district authority tax amount will be posted to 
under the Revenue Account setup. 

TR_QST G/L account where the state authority tax amount will be posted to under 
the Revenue Account setup. 

 
 

G/L setup for General Purchase Process  

Maintain the appropriate G/L account under the Expense Account setup for each authority level. 
This would be the required setup to support the Purchase processes. 
 
Create a G/L account in the Asset category called "Purchase Tax Clearing account." This account 
will be used for expense purposes related to the integration. 
 
The screenshot below shows the setup of the Purchase Tax Clearing account. 
 

 
 
 
 
 
 
 

File Edit View Data GoTo Modules Help TRUS|manager

ÿ

G/LAccount 13600000 0100101 Level 10
Name Purchase Tax ClearingAccountAssets Assets

Current Assets-CurrentAssets
G/L Account Details Cash and Equiv-Cashand CashEquivalents
e Active Accgunt Liabilities
External Code 12100000-01-001-01-AccountsReceivable-DomesticÿHO,USA,GA)
Currency AllCurrencies 12200000-01-001-01-AccountsReceivable-ForeignÿHO,USA,GAÿ Equity
Confidential Level 4 12400000-01-001-01-AllowanceforDoubtful Debts(HO,USA,GA)

12500000-01-001-01-InterestReceivableÿHO,USA,GA)
Balance -47.50 # 12510000-01-001-01-OtherReceivablesÿHO,USA,GA)

G/LAccount Properties 12540000-01-001-01-Travel Expenses-Advances(HO,USA,GA)
Inventory-InventoryAccount Type Other 13100000-01-001-01-Inventory-RawMaterialÿHO,USA,GA) Cost of Sales

Control Account
BlockManual Posting 13200000-01-001-01-Inventory-Work InProgressÿHO,USA,GA)
Cash Account 13300000-01-001-01-Inventory-SemiFinishedGoodsÿHO,USA,GA) Expenses

Beval.(Currency) 13400000-01-001-01-Inventory-FinishedGoodsÿHO,USA,GA)
13500000-01-001-01-Inventory-ReturnsÿHO,USA,GA)
13900000-01-001-01-Goods Clearing Account(HO,USA,GA) FinancingCashFlow Relevant Other Current-Other CurrentAssets

Relevant for Cost Accounting 14100000-01-001-01-Prepaid ExpensesÿHO,USA,GA)
14200000-01-001-01-PrepaidTaxesÿHO,USA,GAÿ Other Revenues a..

Project 15100000-01-001-01-LoansReceivable-ShortTermÿHO,USA,GA)
15200000-01-001-01-Accrued Expenses-ShortTerm(HO,USA,GA) 6#
13600000-01-001-01-PurchaseTaxClearingAccount(HO,USA,GA)

FixedAssets-Fixed Assets
Cost-Cost #10

16100000-01-001-01-Land&LandImprovementsÿHO,USA,GA)

06/01/23 SAPuo3:19PM

 

 

 

        

 

     
    

   
   

  
    

    
 

    
 

 
     

 
  

   
 

 
 

    

 
 

 
  

   
 

  
 

   



 

 
 
For Canada, the following authority levels are defined. 
 
Tax Account Description 
TR_GST G/L account where the city authority tax amount will be posted to 

under the Expense Account setup. 

TR_HST G/L account where the county authority tax amount will be posted to 
under the Expense Account setup. 

TR_PST G/L account where the district authority tax amount will be posted to 
under the Revenue Account setup. 

TR_QST  G/L account where the state authority tax amount will be posted to 
under the Revenue Account setup. 

  
By setting up the G/L accounts as described above, you can ensure that the tax amounts collected 
for each authority in the processes are accurately recorded as revenue. Expenses related to these 
tax amounts will be recorded in the "Purchase Tax Clearing Account." 
 

Additional G/L setup for Vendor Charged Tax Process  

Additionally, if you are implementing the Vendor Charged Tax functionality within ONESOURCE 
Determination, additional G/L accounts are required. 
 
NOTE : The application of VCT for ONESOURCE Determination is limited to the PST portion  
 
Create a special G/L account in the Asset category called "Purchase Tax Clearing account." This 
account will be used for expense purposes related to the integration. 
 
Assign the "Purchase Tax Clearing account" to all "TR_" related components except for 
"TR_TaxAccrue." This ensures that expenses associated with these components are recorded in the 
designated G/L account. 
 
For the "TR_TaxAccrue" component, apply the Accrual Tax account. This account is specifically 
used for accruing variances related to the Vendor Charge Tax (VCT) functionality. This G/L account 
is to be in created under the Liability section. 
 
 

Tax Account Description 

TR_OverCharge G/L account in expenses where the VCT overcharge tax amount will be 
booked during purchase. Apply the "Purchase Tax Clearing Account." 

TR_TaxAccure G/L account in expenses where the VCT Accrue Variance tax amount will be 
booked during purchase. Apply the “Accrue Variance Account”. 



 

TR_XAdjustC 

G/L account used when an AP invoice is canceled, or when an AP credit 
note is created after Landed Cost document is created to settle the tax 
amount evaluated through Landed Cost. Apply the "Purchase Tax Clearing 
Account". 

TR_XAdjustD 

G/L account used when an AP invoice is canceled, canceled, or when an AP 
credit note is created after Landed Cost document is created to settle the tax 
amount evaluated through Landed Cost. Apply the "Price Difference 
Account" here. 

 
 
By configuring these G/L accounts as specified, you can ensure that the relevant tax amounts and 
adjustments are correctly recorded in the expense accounts during the purchase process, taking into 
account VCT overcharges, Accrue Variance, and adjustments due to cancellations or credit notes. 

Master Data Maintenance 

This section lists the required master data that needs to be configured in your SAP Business One 
client. 

Customer Addresses (Ship-To) for Sales 

Addresses are important elements to determine the tax for shipping goods from one location to 
another location. In this solution, ship-to addresses are defined in the customer master.  
 
To define the ship-to addresses, go to Business Partner Master Data > Addresses tab. Select 
address type Ship-To, and click on Define New. 
 

 
 
 

Business Partner Master Data

Manual C002 Customer Local Currency
Name ON Account Balance 2,260.00
Foreign Name Deliveries 0.00
Group Customers Orders ÿ 2,260.00
Currency Canadian Dollar Opportunities
Federal Tax ID

Checks

General Contact Persons Addresses Payment Terms Payment Run Accgunting RemarksAttachments

Bill To Ship To Show Location in Web Browser

Define New Address ID ON
Ship To Address Name 2
NO Address Name 3
Define New Street / PO Box

City
apoo dz
County
State oo

Canada

eaa se a5t

 

    
    

   
     

   
 

 

        

   

   
  

  
  

 
 
 

  
 



 

Enter the Address ID. Under the Country/ Region field, by default, this information will be populated 
per the country localization settings. You may change this information if required. 
 
Enter the address details like state, county, city, Zip code/Postal Code, Geo Code etc.  
Save the address.  

Customer Registration Number (Buyer Registration)  

ONESOURCE Determination uses registration numbers as a component to determine which 
Canadian taxes applies to the transaction. Maintain the customer tax registration number on the 
Business Partner Master Data under the field Federal Tax ID. 
 

 
 
Delivery Terms (Incoterms) 
 
Enter the incoterms (delivery terms) in the logistic Tab under sales documents, there will be 
predefined all the standard delivery terms are automatically in sales documents. 
 

 

Business Partner Master Data

Code Manual CUS006 Customer Local Currency
Name Customer-BC Account Balance 15,344.00
Foreign Name Deliveries 0.00
Group Customers Orders 52,192.00

Currency Canadian Dollar Opportunities
Federal Tax ID 123456789RT

Checks

General Contact Persons Addresses Payment Terms Payment Run Accounting s Remarks Attachments

Tel 1 Contact Person

ID No. 2
Mobile Phone Unified Federal TaxID 123456789RT
Fax

Sales Order

Customer C001
Name BC
Contact Person
Customer Ref. No. B1-GST-PST-TEST

Local Currency

Contents Logistics Accounting Attachments

Ship To BC
BC CANADA

Bill To

Shipping Type
Delivery Term DDP

 

     
    

   
    

   
  

 

         

  

 
   

 

  
  

 
  

 

    

  
  

 

 
 



 

 

Vendor/Supplier Addresses (Ship-From) for Purchase 

Addresses are important elements to determine the tax for shipping goods from one location to 
another location. In this solution, ship-from addresses are defined in the supplier/vendor master.  
 
To define the ship-from addresses, go to Business Partner Master Data > Addresses tab. Select 
address type Ship-To, and click on Define New and enter the Ship From address name and other 
details like State, city, Zip code, GLN (geo location no/County no) etc. Multiple ship-from addresses 
can be entered. 
 

 
 
During the order creation process, the Ship-From field on the Logistics tab will be available for 
selection. This customized field will come automatically when you install the Thomson Reuters 
integration package.  



 

  

Warehouse Addresses (Ship-From/Ship to) and Registration 
Numbers 

The Ship-From and Ship-To address is an important element for tax determination to indicate 
shipping of goods from the seller’s warehouse to the Buyer’s ship-to location. Warehouse address 
can play both roll as ship from (in case of Sale) as well as ship to (in case of Purchase).   
 
In SAP Business One, the company address is managed in the company master as the registered 
address. However, warehouse locations may differ from this based on the warehouse used during 
the sales and purchase transaction. 
 
To ascertain the correct tax, both the buyer and seller must have a registration number. In the 
warehouse master, users are required to input the tax registration number in the Federal Tax ID 
field. During sales transactions, this registration number serves as the seller's role, while in 
purchases, it functions as the buyer's role. Additionally, the supplier's registration number is utilized 
as the seller's role in the context of a purchase transaction. 
 
To maintain the warehouse address and tax registration numbers, go to Administration > Setup > 
Inventory > Warehouses. 
 
 Enter the required address fields e.g., Country, State, County, City, Zip Code, Geo Code etc. and 
VAT Registration number in the Federal Tax Id field. 
 
 

Purchase Order

Vendor SUP001
Name Vendor 1
Contact Person
Vendor Ref. No.
Local Currency

Contents Logistics Accounting Attachments

Ship To Victoria BC
CANADA

Pay To Montreal QC
Pay to CANADA

Shipping Type
Ship From Ship From - Montreal
Delivery Term

 

  
  

 
 

 

    

  
 

  

  

 
  



 

 
  

Warehouses - Setup

Warehouse Code EO Warehouse Name Victoria, British Columbia

General Accounting

 Drgp-Ship
o xe

Location Nettable
 Allow Use Tax

Street/PO Box
Street No. Enable Bin Locations

Block
Building/Floor/Room
apo dz
City Victoria
County
Country/Region Canada
State British Columbia
Federal Tax ID 122306789
GLN Show Location in Web Browser
Tax Office
Address Name 2
Address Name 3

 

    

  

 
 

  
 

 
  

 
 

 
  

 
  

  
  

  
 

 



 

Additional Supported Functionality 
User Element Attributes  

For this integration we have provided the ability to send an additional 40 User Defined Fields (UDFs) 
to ONESOURCE Determination for complex tax determination cases. These additional fields are 
mapped to ONESOURCE Determination as Custom Attributes at both the Invoice and Line Level. 
This configuration is optional. 
 
Depending on your tax requirements, you have the ability to map and send up to 50 additional field. 
Here, you will be able to utilize any fields available within the SAP Marketing Document fields or set 
default values.  
 
In this example below, a new custom Marketing Document field is created to represent the 
“Distribution Channel.” 
 
Note: You may create new custom field via the Menu Tools> Customization Tools> User Defined 
Fields – Management under the category Marketing Documents.  
 
To map the fields or default values to the Header or Line Level attributes, navigate to the TR 
Configuration Screens (Modules > Administration> Setup> TR Configuration> Header attribute or 
Line Attribute tab) 
 
In the example below, a new custom field has been created to capture the distribution channel for 
the sales transaction. This is map to Header level User Attribute 1 under the column SAP UDFs. 
Alternatively, if you may send fixed or default values to ONESOURCE Determination in the attributes 
by defining the mapping under the column Static/Default Value  
  



 

 

Product Tax Category 

Product Tax Category is an important element for tax determination as it categorizes a group of 
items or products having different taxability treatment. This Integration supports either categorization 
by Commodity Codes or Product Codes. 

Commodity Codes 

Maintain Commodity Codes under the field Commodity Classification within the Item Master Data  
 

TR Configuration x

Company Info Header Attribute Line Attribute Other Settings
# TR Attributes SAP UDFs  Static/Default Value

Attribute01 U_DChannel
2 Attribute02 CIF
m Attribute03
4 Attribute04
5 Attribute05
6 Attribute06
7 Attribute07
8 Attribute08
9 Attribute09
10 Attribute10
11 Attribute11
12 Attribute12
13 Attribute13

14 Attribute14
15 Attribute15
16 Attribute16
17 Attribute17

OK Cancel

  

    

    
  

   
  

  
  

  

  
  

  

  

  

  
  
  
  
  

  

 



 

 
 

Product Code Mapping 

 
Various options are provided within this integration for Product Code Mapping. 
Navigate to the TR Configuration menu. From the Main Menu, go to Administration> Setup> TR 
Configuration > Other Settings> Product Code. 
Here you will select which field on the Item Master Data should be mapped to the Product Code field 
for tax determination. 
 

Item Master Data ÿx

Item No. Manual 00110 Inventory Item
Description Item No1 With Product Code and commotidiSales Item 
Foreign Name Purchasing Item
Item Type Itemis
Item Group Items
UoM Group Manual ÿ Bar Code
 Price List Price List 01 Unit PricePrimary Curre

General Purchasing DataSales Data Inventory Data Planning Data Production DataProperties Remarks Attachments 

 Tax Liable

 Do Not Apply Discount Groups
 Manufacturer  No Manufacturer -
Additional Identifier
 Shipping Type
Serial and Batch Numbers
Aq walI abeue None

O Active From Remarks

 Inactive
O Advanced

Country/Region of OriginUSA

Commodity Classification02

OK Cancel

  

    
  

  
  
  

    
   

     

 

 
 

 
 

 
  

   
 

 

  

  

 



 

 
 

1. There are four options to map the product code as follows: 
 

Field Description 

Item Code This is the item code of the material.  

Item group An item group also can be mapped as product code 

Standard Item Identification Items standard identification also can be set as product 
code. 

Item User Defined field User can also use UDF to determine the product code. 

 
 

 
 
 
 

TR Configuration

Company Info Header Attribute Line Attribute Other Settings

Product Code Item Code

Item Code
2 Item Group
3 Standard Item

UDF Value

Item Master Data

Item No. ManualIITM00005 Inventory Item Product Code L00024
Description Item No2 With Commodity  Sales Item
Foreiqn Name
Item Type Items
Item Group Items
UoM Group Manual Bar Code
Price List Price List 01 Unit Price Primary Curr

GeneralPurchasing Data Sales DataInventory DataPlanning DataProduction DataPropertiesRemarksAttachments

 Tax Liable

Do Not Apply Discount Groups
Manufacturer - No Manufacturer -
Additional Identifier
Shipping Type
Serial and Batch Numbers
 Manage Item by None

Country/Region of Origin USA
Standard Item Identification8471.30
Commodity Classification 78.100

OK Cancel

 

    

  

 

  

  

 

     

   
 

  
  
   

    

      

 

 
  

 
 

 
  

  
  

  

 



 

Freight and Delivery Costs  

Within the integration with ONESOURCE Determination, tax determination is supported for freight 
lines entered within sales or purchase documents in SAP Business One. Freight charges can be 
added at either the document level or the line level, providing flexibility in capturing freight-related 
expenses. 
 
To add freight charges at the document level: 
 

1. Open the sales or purchase document (e.g., sales order, sales invoice, purchase order, etc.) 
in SAP Business One. 

2. Locate the freight-related field or section within the document header, which allows you to 
enter the freight charges. 

3. Enter the appropriate freight amount or percentage in the designated field. 

4. Save the document. The integration will consider the freight charges entered at the 
document level for tax determination. 

5. To add freight charges at the line level: 

6. Open the sales or purchase document (e.g., sales order, sales invoice, purchase order, etc.) 
in SAP Business One. 

7. Navigate to the line-item section of the document. 

8. Select the desired line item where you want to add freight charges. 

9. Within the line item details, locate the field or column dedicated to capturing freight charges. 

10. Enter the applicable freight amount or percentage for the specific line item. 

11. Save the document. The integration will consider the freight charges entered at the line-item 
level for tax determination. 

 
By supporting tax determination on freight lines, the integration enables accurate calculation and 
application of taxes on freight-related expenses within sales or purchase transactions. This ensures 
compliance with tax regulations and provides visibility into the tax implications of freight charges. 
 



 

 
 

The following freight scenarios are explained below: 

Freight at line level  

When freight is entered at the line level, it is assessed based on the product code or commodity 
code sent with the line item.  

If freight charges are applied to line items, the system will examine the product code or commodity 
code associated with the charges and calculate the applicable taxes based on predefined rules. 
Users will be able to view the tax details corresponding to each line item, providing clear visibility into 
how taxes are calculated. 

Freight at header level 

Freight charges or any other charges can be applied at document level, and be distributed based on 
distribution methods such as: 

• Quantity 

• Volume 

• Weight 

• Equally 

• Row Total 

 

Sales Quotation

Customer C0001 No. Primary 25
Name envolkan@gmail.com | Engin Vd Status Open
Contact Person 0 Posting Date 09/23/22
Customer Ref. No.Commerce_US_Shipping_Return Valid Until 10/23/22
Local Currency Document Date 09/23/22

Contents Logistics Accounting Attachments

Item/Service TypeItem Summary TypeNo Summary
 Item No. Item Description Quantity  Discount % Tax CodeTotal (LC)Whse Tax LiableFreight 1Freight 1 (LC)Distribute Freight Distrib. Amount (LC)UoM CodeUoM NameCountry/Region ..
> 12 Item No1 With Product code 5 $ 34.00 0000 NA $ 170.008Mÿ Yes Yes Manual EACH USA

00102 Item No1 With Product Code 5 $ 7.50 0.000ÿ NA $ 37.50 => W8Yes ÿ Yes ÿ Manual EACH USA
0.000 Freight

Handeling Charges
Other Charges

TR_CountyTax

TR_StateTax

Sales EmployeeNo Sales Employee-ÿ ÿ
Owner
Tax Amount 14.03

Discount %
Sales Tax & Freight $ 14.03
 Rounding
xe1
 Total 25'122$

Remarks ok

OK Add Draft & NewCancel Calculate Tax Copy From Copy To

 

     
    

    
    
   

    
    

          
             

              
  

 
 

 

 

    
 

  
  

  
 

 
 

  

    



 

In this solution, we also handle scenarios where taxes need to be calculated based on distributed 
values. If a distribution rule is selected, the respective tax will be calculated accordingly. However, if 
no distribution rule is chosen, the charges line items will be treated as separate line items for tax 
calculation purposes. The details of the tax calculation will be displayed in the Freight table. 
 

 

To set up the product code mapping for freight, go to Modules> Administration> Setup> General> 
Freight. 

 

Vendor Charged Tax and Postings 

This integration now supports fully the Vendor Charged Tax Verification functionalities of 
ONESOURCE Determination. This section explains the solution and related configuration to support 
VCT-V and related postings.  

Freight - Setup

Name Revenue Account Expense Account Fixed Amount - Revenues

1 FREIGHT 41400000 65500000
2 Handelling Charges 41400000 65500000

3 Other Charges 41400000 65500000
4 TR_GST +

5 TR_HST ÿ 2

6 TR_OverCharge ÿ

7 TR_PST 24280000 24480000

8 TR_QST 24280000 2 24480000

TR_TaxAccure 25150000
10 TR_XAdjustC + 15200000

TR_XAdjustD 15200000

12

3

OK

 

    

    

    

    

   

  
  

   

    

     

  

    
  

 

 



 

Postings using Landed Cost Document (for PST provinces only) 

Note: The VCT-V functionality supports only PST like Provinces/ Tax authorities 
 
When integrating with ONESOURCE Determination, the Landed Cost document facilitates the 
allocation of PST Tax to the appropriate expense or revenue line. This functionality enables the 
addition of the tax amount to the item cost, considering that PST is a non-deductible tax. 
 
For other tax authorities such as GST, HST, and QST, the landed cost functionality does not apply. 
Taxes for these authorities will be posted to a designated tax account. This approach ensures 
precise allocation of tax amounts and maintains proper accounting treatment within the system. 
 
Here is an example scenario to illustrate the process: 
 

1. An A/P (Accounts Payable) invoice is created in SAP Business One for a purchase 
transaction. The tax amount determined by ONESOURCE Determination is $120.  

2. The vendor charged tax is $135. This is the tax amount invoiced by the supplier/vendor. In 
this case the PST Tax amount is $78.75. 

3. The VCT (Variance Calculation Technique) accrual method configured in ONESOURCE 
Determination is Pay_VCT_NO_ACCURAL. This means that the tax charged by supplier that 
will be paid to the supplier. 

4. When the A/P invoice is posted, the integration automatically triggers the creation of a 
Landed Cost document. This document is linked to the A/P invoice and serves to distribute 
the PST tax amount to the appropriate expense or stock line. 

5. In this example, the Landed Cost document will be created with a total tax amount of $78.75, 
representing the PST Tax amount, which is allocated to Stock. 

6. The Landed Cost document will then allocate the PST tax amount to the relevant expense or 
stock line based on the configuration and mapping set up in the system. 

 
By using the Landed Cost document in this way, the integration ensures that the tax amount is 
accurately distributed to the appropriate expense or revenue line. This allows for proper accounting 
treatment and provides visibility into the tax implications of the purchase transaction. 
 

At time of A/P Invoice 
CR Vendor 

 
$113.5 

DR Inventory $100 
 

DR GST Tax Account $5.625 
 

DR  PST Tax Account $7.875 
 

    

Landed Cost Document 
  

DR Inventory $7.875 
 

CR PST Tax Account 
 

$7.875 
 
 
 



 

Alternate Option for Postings to Separate Input Tax Account (for 
PST provinces only) 

In the standard functionality of SAP Business One, the tax amount is typically posted to a separate 
General Ledger Input Tax account. However, in the integration with ONESOURCE Determination for 
Canada, the use of the Landed Cost functionality is recommended for PST tax allocation only. 
 
If you prefer to use the standard functionality of SAP Business One and post the tax amount to a 
separate Input Tax account, you have the option to disable the use of the Landed Cost functionality 
within the integration. Here is how you can do it: 
 

1. Navigate to the TR Configuration Menu within SAP Business One. 

2. Go to Other Settings, which can typically be found under the TR Configuration menu. 

3. Locate the "Post Landed Cost" option and uncheck the box associated with it. 

4. Save the changes to apply the configuration. 

 
By turning off the "Post Landed Cost" option, the tax amount will no longer be distributed using the 
Landed Cost functionality. Instead, it will follow the standard functionality of SAP Business One and 
be posted to the designated Input Tax account. 
 
It is important to note that by disabling the use of Landed Cost functionality, you may not achieve the 
same level of tax allocation accuracy and detailed reporting as provided by the integrated solution 
with ONESOURCE Determination. Therefore, it is recommended to carefully consider the 
implications and requirements of your tax compliance process before deciding to disable the Landed 
Cost functionality. 
 
 



 

 

Vendor Charged Tax Processes 

Refer to the Vendor Charged Tax documentation on the Thomson Reuters Help Centre for more 
information on the VCT functionality within ONESOURCE Determination. 
 

1. Ship-From Address Selection for Purchase Process: 
• In this solution, the ship-from address for the purchase process is determined using a 

User Defined Field (UDF) in the Logistics tab of the Purchase order by selecting the 
address id from the Supplier master. If there are multiple addresses maintained for 
the Supplier Master, user will be able to select the appropriate address.  

 

TR Configuration

Company Info HeaderAttribute Line Attribute Other Settings

Product Code Item Code

URL https://api-cloud-sat.onesourcet.

Post Landed Cost

OK Cancel

 

    

  

  

 

 



 

 
• By default, the system will automatically select the first ship-from address available 

for the vendor. 

• If there are multiple ship-from addresses defined for a vendor, the user will need to 
manually select the appropriate address during the purchase process. 

 
 

2. Vendor's Charge Tax (VCT) in A/P Invoice: 
 

• Vendor's Charge Tax (VCT) is applicable only in A/P (Accounts Payable) invoices 
and for the PST provinces in Canada 

• If VCT is configured in the tax determination process, the system will validate the 
VCT amount and the calculated tax amount. 

• If there is a difference between the VCT amount charged by the vendor and the 
calculated tax amount determined by ONESOURCE, the system will not allow the 
user to post the transaction. 

• This ensures that the tax amounts are accurately calculated and aligned with the tax 
determination results. 

Please note that the specific steps and user interface may vary depending on the version and 
configuration of your SAP Business One system. It is always recommended to consult the official 
documentation or reach out to your system administrator for detailed guidance on performing these 
actions within your specific setup. 

Invoicing and Commit Calls 
The tax calculation process remains the same for all the documents, including sales quotation, sales 
order, A/R invoice, A/R credit note, purchase quotation, purchase order, A/P invoice, and A/P credit 
memo. However, during the financial posting of invoices or credit documents, a commit call is 
triggered to save the tax information to the TR Audit or report database. 
 

Purchase Order

Vendor SUP001
Name Vendor 1
Contact Person
Vendor Ref. No.
Local Currency

Contents Logistics Accounting Attachments

Ship To Victoria BC
CANADA

Pay To Montreal QC
Pay to CANADA

Shipping Type
Ship From Ship From - Montreal
Delivery Term

 

 

  
  

 
 

 

    

  
 

  

  

 
  



 

The commit call ensures that the tax information is securely and accurately stored in the reporting 
database for further analysis and reporting purposes. Without the commit call, the tax information will 
not be saved in the reporting database, and it may not be available for generating reports or 
conducting analysis on tax-related data. 
 
By triggering the commit call, the system ensures that the tax information is properly recorded and 
can be accessed when needed for auditing, compliance, or analysis purposes. This allows users to 
have a comprehensive view of the tax-related transactions and enables them to generate reports or 
perform analysis based on the saved tax information in the reporting database. 

 

Logging and Monitoring  
Using the Unified Logging Feature  

To access the logging feature in ONESOURCE Determination, follow these steps: 
 

1. Login to ONESOURCE Determination. 

2. Click on "Tools" in the menu. 

3. Select "Tax Tools" from the dropdown menu. 

4. Choose "Unified Logging" from the options. 

 
To find the relevant logs, use the Correlation Id displayed on the SAP Business One screen. The 
Correlation Id is a unique identifier that helps you locate specific logs.  
 
On the Unified Logging page in ONESOURCE Determination, you can find logs related to the SAP 
Business One Integration for Tax API. These logs contain information about the input and output 
data exchanged between ONESOURCE Determination and SAP Business One. 
Additionally, you can also access logs related to the Determination process itself. These logs provide 
details about the input data sent to ONESOURCE Determination for tax calculation and the 
corresponding output results. 
 
By reviewing these logs, you can gain insights into the data flowing between ONESOURCE 
Determination and SAP Business One, as well as the tax determination results. This information can 
be valuable for troubleshooting, analysis, and auditing purposes. 



 

 

 

API Request Log file 

In this integration whenever a tax call will happen, system will generate a tax call request log in the 
add-on folder with the respective information which will be consumed by the tax engine and based 
on the details system will calculate the tax and return the result. But if there is any information is 
missing in the document then system may show an error like “API error,” it means there is no 
specific error was found by the tax engine but there is something wrong. So, user can check the 
request log and easily find out the missing information. User can find the log folder in below path 
 

THOMSONREUTERS Chandra Tangudu
INDIRECTTAX TENANTIndirectTaxIntegrationsSAT(VGDÿ

Dashboard Companies Configuration Exemption Certificate Tools Reports&Analytics Help

Unified Logging

externalCompanyld:"INTSAPDEV_USBusinessOne" KQL ~3monthsago now CRefresh

correlationld:139_20230323183202x +Addfilter

21documents

Time content loggingSystem contentType externalCompanyld contentld correlationld traceld

Mar24,2023@00:02:03.000 {"companyRol determination Request Payload INTSAPDEV_USBusinessOne 139_202303231832

e":"s","externalcomp 02
anyId":"INTSAPDEV_US
Businessone","invoic
e":[{"calculationDir
ection":"F","currenc
vCode":"UsD"."invoic

Mar24,2023@00:02:03.000 {"companyRol tax-api ResponsePayloadINTSAPDEV_USBusinessOne 139_202303231832
e":"s","externalcomp 02
anyId":"INTSAPDEV_US
Businessone","statu
s":{"isSuccess":tru
e,"isPartialSucces
s":true}."document

Mar24 2023@99.02.0309 TavEin determinatinn Tay R1nck Meccan TNTSAPDEVlISRusinessOne 139 292393231832

File Edit View Data GoTo Modules Tools Window Help TRTEST|manager

A/PInvoice

ItemNo1WithProductC.5 $7.50 0.000 N/A $37.50 w...
3 FREIGHTFreight $8.19 0.000 N/A $8.19 ÿ w...

3uyer -NoSalesEmployee- Total BeforeDiscount$215.69
Owner Discount %
raxAmount 14.71 TotalDownPayment
CorrelationId 141_20230228094028 PurchaseTaxFreight $14.71
lendorTaxAmount 14.71 Rounding

Tax
PaymentOrderRun Total PaymentDue $230.40

Remarks AppliedAmount
Balance Due $230.40

  
  

       

 

     

  

 

        

      
  
 

 
 
 

 

      
  
 

 
 

 
 

      

          

 

      
         

    
   

   
    

   
 

   
  

 



 

“C:\Program Files\SAP\SAP Business One\AddOns\Thomson Retures\TRC indirect Tax Utility – 
1.2.0.0\X64Client\LogFiles” 
 
This log file can be auto deleted as per user needs. By deafult there will be no delete applied, but if 
user wants system should keep log files for certain period say last 10 days, then user needs to apply 
the days is the application config files using the below path 
“C:\Program Files\SAP\SAP Business One\AddOns\Thomson Retures\TRC indirect Tax Utility – 
1.2.0.0\X64Client\” and select the config file “VAT_Calculation.exe.config” and right click on the file 
and select “open with note pad” and change the “daysOld” value 0 to 10 (0 will be default). 
 

 
 
Please note that the specific steps and user interface may vary depending on the version and 
configuration of your SAP Business One system. It is always recommended to consult the official 
documentation or reach out to your system administrator for detailed guidance on performing these 
actions within your specific setup. 

Monitoring Reports  

To monitor invoices processed with tax calculated from ONESOURCE Determination, users can 
access the Document Draft Reports in the SAP Business One Reports module. Here is how: 
 

1. Click on the "Reports" menu in SAP Business One. 

2. Navigate to the "Sales and Purchasing" section. 

3. Select the "Document Drafts Report" option. 

 
By running this report, users will be able to view a list of document drafts, including invoices, which 
have been generated with tax calculations performed by ONESOURCE Determination. This report 
provides valuable information for tracking and reviewing invoices before they are finalized and 
posted. 
 

Calculation.exe.config-Notepad

FileEditFormatViewHelp
<?xml version="1.0"encoding="utf-8"?>
<configuration>

<appSettings>
<add key="days0ld" value="10"/>

</appSettings>
<runtime>

<assemblyBinding xmlns="urn:schemas-microsoft-com:asm.v1">
<dependentAssembly>

<assemblyIdentity name="System.Runtime.CompilerServices.Unsafe" publicKey
/>

<bindingRedirect oldVersion="0.0.0.0-6.0.0.0" newVersion="6.0.0.0" />
</dependentAssembly>

</assemblyBinding>
</runtime>

</configuration>

 

 

 
 

 
 

 
 

 
 

 
 

 
 

 
 

 



 

 
 
To review the drafted reports with tax amounts in the SAP Business One Document Drafts  
 
Report, follow these steps: 
 

1. Click on the "Document Drafts Report" option in the SAP Business One Reports menu. 

2. In the report parameters or selection screen, select the functional area for which you want to 
review the draft reports. This could be either sales or purchasing, depending on your 
requirements. 

 
By selecting the functional area, the Document Drafts Report will filter and display the relevant draft 
reports for the chosen area, including the tax amounts calculated by ONESOURCE Determination. 
This allows users to review the draft documents, verify the tax calculations, and make any necessary 
adjustments before finalizing the invoices or purchase orders. 

File Edit view Data GoTo Modules Tools Window Help ikicoiImdndyer

d Search Search by Template
Production

MRP

Service

RHumanResources

Reports

Financials

CRM

Opportunities

SalesandPurchasing

OpenItemsList

DocumentDraftsReport

Backorder

SalesAnalysis

PurchaseAnalysis

          

   
 

 

 

 

 

 

 

 

 

 

 

 

 



 

 
Click on OK button to see all drafts report with tax amount.  
 

 

ÿ
DocumentDraftsReport-SelectionCriteria

User manager Open Only

Date

Sales-A/R Purchasing - A/P

Sales Quotations Purchase Request
Sales Orders Purchase Quotation
Deliveries Purchase Orders
Return Request Goods ReceiptPO

Returns Goods Return Request
A/RDownPayment Goods Return
A/RInvoices A/PDownPayment
A/RCreditMemos A/PInvoices

A/PCreditMemos

Inventory InventoryCountingTransactions

Goods Receipt Inventory Counting
Goods Issue InventoryOpening Balances
Inventory Transfer Request Inventory Posting
InventoryTransfers M

OK Cancel

DocumentDraft

DraftNoDocument Document No.Posting Date Total Total Tax VendorTaxAmo

3 A/PInvoices 32 01/16/23 $12,990.00 990.00 800.00

5 A/PInvoices 52 01/25/23 $12,500.00 866.25 700.00
7 A/PInvoices 70 02/13/23 $14,072.50 1,072.50 500.00
8 A/PInvoices 72 02/15/23 $ 12,990.00 990.00 600.00

9 A/PInvoices 73 02/21/23 $114.10 9.10 0.00

OK Cancel

 
 

   

 

  

  
  

  
  

  
  

  
  

 

  

  
  

  
  

 

 

     

       
       

       

       

       

 



 

  

Data Mapping 
Sales Process 

Request Payload Mapping Fields  

ONESOURCE REST API Fields Business ONE 
Fields Transformation/ Description 

Header.externalCompanyId U_INTID External company id is obtained from 
TR configuration screens and sent to 
REST API along with secret id/ key, 
which will be validated for further 
processing 

Header.companyRole   if the transaction type is Sales 
(Objtype in (13,14,17,19)) then 
CompanyRole="S" and when 
transaction type is Purchase 
(ObjType in (22,23,18,19)) then 
CompanyRole='B'  

Documents.Address.type OINV.ShiToCode Where Header.adderssType='ST' set 
Type=shipTo 

Documents.Address.country OINV.CountryS Where Header.adderssType='ST' 
Documents.Address.region OINV.StateS Where Header.adderssType='ST' 
Documents.Address.City OINV.CityS Where Header.adderssType='ST' 
Documents.Address.county OINV.CountyS Where Header.adderssType='ST' 
Documents.Address.postcode OINV.ZipCodeS Where Header.adderssType='ST' 
Documents.Address.geocode OINV.GlbLocNumS Where Header.adderssType='ST' 
Documents.Address.Type OWHS.ShiToCode Where Line.adderssType='SF' set 

Type=shipFrom 
Documents.Address.country OWHS.CountryS Where Line.addressType='SF' 
Documents.Address.region OWHS.StateS Where Line.addressType='SF' 
Documents.Address.City OWHS.CityS Where Line.addressType='SF' 
Documents.Address.county OWHS.CountyS Where Line.addressType='SF' 
Documents.Address.postcode OWHS.ZipCodeS Where Line.addressType='SF' 
Documents.Address.geocode OWHS.GlbLocNumS Where Line.addressType='SF' 
Documents.Currency OINV.DocCur   
Documents.documentDate OINV.DocDate   
Documents.Line.lineNumber INV1.LineNum   
Documents.Line.productCode INV1.StdItemId   
Documents.Line.commodityCode INV1.CommClass   
Documents.Line.quantities INV1.Quantity   
Documents.Line.taxableBasis INV1.LineTotal   



 

Document.registrations.type 
 

sellerRoll 
Document.registrations.registrationNumber OWHS.FedTaxId 

OADM.TaxIdNum, 
OADM.TaxIdNum2, 
OADM.TaxIdNum3, 

sellerRegistration No 

Document.registrations.type 
 

buyerRoll 
Document.registrations.registrationNumber OCRD.VatIdUnCmp, 

OCRD.LicTradNum 
buyerRegistration No 

Document.deliveryTerm.type 
 

incoterms 
Document.deliveryTerms.term OINV_TERM As per stanadard 

Response Payload Mapping Fields 

ONESOURCE REST API 
Fields 

Business ONE 
Fields Transformation/ Description 

Header.externalCompanyId TR_CONF1.U_INTID External company id is obtained from TR 
configuration screens and sent to REST API along 
with secret id/ key, which will be validated for 
further processing 

Header.companyRole   if the transaction type is Sales (Objtype in 
(13,14,17,19)) then CompanyRole="S" and when 
transaction type is Purchase (ObjType in 
(22,23,18,19)) then CompanyRole='B'  

documents.companyName TR_CONF1.CMNAME   
documents.companyRole   if the transaction type is Sales (Objtype in 

(13,14,17,19)) then CompanyRole="S" and when 
transaction type is Purchase (ObjType in 
(22,23,18,19)) then CompanyRole='B'  

Documents.currencyCode OINV.DocCur   
Documents.externalCompanyId TR_CONF1.CMNAME   
Documents.transactionDate OINV.DocDate   
Documents.totalTaxAmount OINV.U_TAXAMT   
documents.callingSystemNumber TR_CONF1.U_INTID   
documents.hostName OADM.HostName   
documents.fiscalDate OPCH.DocDate   
documents.documentNumber OINV.DocNumber   
documents.uniqueDocumentNumber TR_CONF1.U_INTID 

+ OINV.DocNumber + 
companyRole + YEAR 

  

Documents.Line.lineNumber INV1.LineNum   
Documents.Line.grossAmount INV1.LineTotal   
Documents.Line.taxsummary.taxableB
asis 

INV1.LineTotal   

Documents.Line.taxsummary.nonTaxa
bleBasis 

  As per commoditycode or product code 

 

 



 

Documents.Line.taxsummary.exemptA
mount 

  As per commoditycode or product code 

Documents.Line.taxsummary.taxRate INV1.U_R As per effectiveZone 
Documents.Line.taxsummary.effective
TaxRate 

INV1.U_R As per effectiveZone 

Documents.Line.transactionType OINV.DocType GS Default 
Documents.Line.totalTaxAmount OINV.U_TAXAMT   
Documents.Line.taxes.responseSumm
ary 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.adminZoneLeve
l 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.authorityType   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.authorityCurren
cyCode 

OINV.DocCur   

Documents.Line.taxes.effectiveZoneLe
vel 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.erpTaxCode   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.exemptAmount.
authorityAmount 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.exemptAmount.
documentAmount 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.grossAmountau
thorityAmount 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.documentDescr
iption 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.jurisdictionText   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.nonTaxableBasi
s.authorityAmount 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.nonTaxableBasi
s.documentAmount 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxAmount.auth
orityAmount 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxAmount.doc
umentAmount 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxRate   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxRateCode   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxableBasis.au
thorityAmount 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxableBasis.do
cumentAmount 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxableCountry   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.addressType   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.authorityName   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.authorityUuid   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Documents.Line.taxes.euTransaction   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.natureOfTax   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.ruleOrder   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxDeterminatio
nDate 

OINV.DocDate As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxPointDate OINV.DocDate As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxType   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxableRegion   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxableCounty   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxableCity   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxableGeocod
e 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.taxablePostcod
e 

  As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.zoneName   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.zoneLevel   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.taxes.ZoneFipsCode   As per ship to and ship from Address and rule 
defined in TR Tax Engine 

Documents.Line.quantities.amount INV1.Quantity   
Documents.Line.quantities.uom INV1.unitMsr   
Document.registrations.type 

 
sellerRoll 

Document.registrations.registrationNu
mber 

OWHS.FedTaxId 
OADM.TaxIdNum, 
OADM.TaxIdNum2, 
OADM.TaxIdNum3, 

sellerRegistration No 

Document.registrations.type 
 

buyerRoll 
Document.registrations.registrationNu
mber 

OCRD.VatIdUnCmp, 
OCRD.LicTradNum 

buyerRegistration No 

Document.deliveryTerm.type 
 

incoterms 
Document.deliveryTerms.term OINV_TERM As per stanadard 

 

Purchasing Process 

Request Payload Mapping Fields 

ONESOURCE REST API Fields Business ONE 
Fields 

Transformation/ 
Description 

 

 

 

 

 



 

Header.externalCompanyId U_INTID External company id is 
obtained from TR configuration 
screens and sent to REST API 
along with secret id/ key, which 
will be validated for further 
processing 

Header.companyRole   if the transaction type is 
Purchase (ObjType in 
(20,22,540000006,18,19)) then 
CompanyRole='B'  

Documents.Address.type OPCH.ShiToCode Where 
Header.adderssType='SF' set 
Type=shipTo 

Documents.Address.country OPCH.CountryS Where 
Header.adderssType='SF' 

Documents.Address.region OPCH.StateS Where 
Header.adderssType='SF' 

Documents.Address.City OPCH.CityS Where 
Header.adderssType='SF' 

Documents.Address.county OPCH.CountyS Where 
Header.adderssType='SF' 

Documents.Address.postcode OPCH.ZipCodeS Where 
Header.adderssType='SF' 

Documents.Address.geocode OPCH.GlbLocNumS Where 
Header.adderssType='SF' 

Documents.Address.Type OWHS.ShiToCode Where Line.adderssType='ST' 
set Type=shipFrom 

Documents.Address.country OWHS.CountryS Where Line.addressType='ST' 
Documents.Address.region OWHS.StateS Where Line.addressType='ST' 
Documents.Address.City OWHS.CityS Where Line.addressType='ST' 
Documents.Address.county OWHS.CountyS Where Line.addressType='ST' 
Documents.Address.postcode OWHS.ZipCodeS Where Line.addressType='ST' 
Documents.Address.geocode OWHS.GlbLocNumS Where Line.addressType='ST' 
Documents.Currency OPCH.DocCur   
Documents.documentDate OPCH.DocDate   
Documents.Line.lineNumber PCH1.LineNum   
Documents.Line.productCode PCH1.StdItemId   
Documents.Line.commodityCode PCH1.CommClass   
Documents.Line.quantities PCH1.Quantity   
Documents.Line.taxableBasis PCH1.LineTotal   
Document.registrations.type  buyerRoll 
Document.registrations.registrationNumber OWHS.FedTaxId 

OADM.TaxIdNum, 
OADM.TaxIdNum2, 
OADM.TaxIdNum3, 

BuyerRegistration No 

Document.registrations.type  sellRoll 
Document.registrations.registrationNumber OCRD.VatIdUnCmp, 

OCRD.LicTradNum 
sellRegistration No 

Document.deliveryTerm.type  incoterms 



 

Document.deliveryTerms.term OPCH_TERM As per stanadard 

Response Payload Mapping Fields 

ONESOURCE REST API Fields Business ONE 
Fields 

Transformation/ 
Description 

Header.externalCompanyId TR_CONF1.U_INTID External company id is obtained 
from TR configuration screens 
and sent to REST API along with 
secret id/ key, which will be 
validated for further processing 

Header.companyRole   if the transaction type is Purchase 
(ObjType in 
(20,22,540000006,18,19)) then 
CompanyRole='B' 
 

documents.companyName TR_CONF1.CMNAME   
documents.companyRole   if the transaction type is Purchase 

(ObjType in 
(20,22,540000006,18,19)) then 
CompanyRole='B' 
 

Documents.currencyCode OPCH.DocCur   
Documents.externalCompanyId TR_CONF1.CMNAME   
Documents.transactionDate OPCH.DocDate   
Documents.totalTaxAmount OPCH.U_TAXAMT   
documents.callingSystemNumber TR_CONF1.U_INTID   
documents.hostName OADM.HostName   
documents.fiscalDate OPCH.DocDate   
documents.documentNumber OPCH.DocNumber   
documents.uniqueDocumentNumber TR_CONF1.U_INTID 

+ OPCH.DocNumber + 
companyRole + YEAR 

  

Documents.Line.lineNumber PCH1.LineNum   
Documents.Line.grossAmount PCH1.LineTotal   
Documents.Line.taxsummary.taxableBa
sis 

PCH1.LineTotal   

Documents.Line.taxsummary.nonTaxabl
eBasis 

  As per commoditycode or product 
code 

Documents.Line.taxsummary.exemptAm
ount 

  As per commoditycode or product 
code 

Documents.Line.taxsummary.taxRate PCH1.U_R As per effectiveZone 
Documents.Line.taxsummary.effectiveT
axRate 

PCH1.U_R As per effectiveZone 

Documents.Line.transactionType OPCH.DocType Defaulted to GS 
Documents.Line.totalTaxAmount OPCH.U_TAXAMT   

 

 

 

 



 

Documents.Line.taxes.responseSumma
ry 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.adminZoneLevel   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.authorityType   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.authorityCurrenc
yCode 

OPCH.DocCur   

Documents.Line.taxes.effectiveZoneLev
el 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.erpTaxCode   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.exemptAmount.a
uthorityAmount 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.exemptAmount.d
ocumentAmount 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.grossAmountauth
orityAmount 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.documentDescrip
tion 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.jurisdictionText   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.nonTaxableBasis
.authorityAmount 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.nonTaxableBasis
.documentAmount 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxAmount.autho
rityAmount 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxAmount.docu
mentAmount 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxRate   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxRateCode   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxableBasis.aut
horityAmount 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

 

 

 

 

 

 

 

 

 

 

 

 



 

Documents.Line.taxes.taxableBasis.doc
umentAmount 

  As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxableCountry   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.addressType   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.authorityName   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.authorityUuid   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.euTransaction   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.natureOfTax   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.ruleOrder   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxDetermination
Date 

OPCH.DocDate As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxPointDate OPCH.DocDate As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxType   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxableRegion   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxableCounty   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxableCity   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxableGeocode   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.taxablePostcode   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.zoneName   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.taxes.zoneLevel   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

 

 



 

Documents.Line.taxes.ZoneFipsCode   As per ship to and ship from 
Address and rule defined in TR 
Tax Engine 

Documents.Line.quantities.amount PCH1.Quantity   
Documents.Line.quantities.uom PCH1.unitMsr   
Document.registrations.type  buyerRoll 
Document.registrations.registrationNum
ber 

OWHS.FedTaxId 
OADM.TaxIdNum, 
OADM.TaxIdNum2, 
OADM.TaxIdNum3, 

BuyerRegistration No 

Document.registrations.type  sellRoll 
Document.registrations.registrationNum
ber 

OCRD.VatIdUnCmp, 
OCRD.LicTradNum 

sellRegistration No 

Document.deliveryTerm.type  incoterms 
Document.deliveryTerms.term OPCH_TERM As per stanadard 

 
 

Sample Transaction (Sales) 
In this section, we will walk through a sample transaction from Sales Quotation to A/R Invoice 
process (Order-to-Cash - O2C) using the SAP Business One integration with ONESOURCE 
Determination. This solution covers various stages of the sales process, including Sales Quotation, 
Sales Order, A/R Invoice, Invoice cancellation, and Credit Note. 
 
Throughout this Order to Cash process, the integration with ONESOURCE Determination ensures 
accurate tax calculations based on the jurisdiction and tax rules. The tax amounts are automatically 
determined and applied to the respective documents, providing compliance and accuracy in tax 
calculation. 

Sales Quotation 

Start with creating a Sales Quotation: Enter the relevant details such as customer information, items, 
quantities, prices, and any applicable discounts. Once the Quotation is prepared, you can save it for 
further processing. 
 
In this example, we will use a customer with a ship-to address as follows: 
 

• Country: CA 
• State: BC 
• City: Vancouver 

Please note that this is a sample address used for demonstration purposes, and you should enter 
the actual customer's ship-to address when performing the transaction in your SAP Business One 
system. 
 

 

 



 

 
The ship-from location for this transaction is as follows: 
 
 

• Country: CA 
• State: BC 
• Seller Registration: R425979 

Please ensure that you enter the accurate ship-from location details based on your specific scenario 
in SAP Business One. 

 
 

Sales Quotation

Customer CUS006
Name Customer - BC
Contact Person
Customer Ref. No.
Local Currency

Address Component
Contents Logistics Street / PO Box

o1 d:45 Vancouver BC Street No.

British Columbia CANADA Block
City Vancouver
apo diz

Bill To Vancouver BC County
British Columbia CANADA State British Columbia

Country/Region Canada

Shipping Type Building/Floor/Room

Delivery Term
Address Name 2
Address Name 3
GLN

OK Cancel

Sales Quotation

Customer CUS006
Name Customer- BC
Contact Person Warehouses - Setup
Customer Ref. No.
Local Currency Warehouse Code [W1 Warehouse NameBC

General Accounting

 Inactive
Contents Logistics Accounting Attachments

Item/Service TypeItem Location

Item No. Quantity Unit Price Discount % o xe Total (LC) Whse
$ 12,000.00 0.00 N/A $ 12,000.00ÿW1

Street/PO Box
Street No.

apo di
City
County
Country/Region Canada
State British Columbia
Federal Tax ID R425979
GLN

 

  
  

 
 

 

 
   

   

   
  

 
   

 
   

  

 
 

 
 
 

 

 

 

  
  

  
 

     

  

 
    

  
 

       
     

 
 

 
 

 
  

  
  



 

For the line item of the transaction: 
 

• Product Code: ITM0002 
• Commodity Code: [Please provide the commodity code if available] 

• Quantity: 1 

• UOM (Unit of Measure): Each 

• Taxable Value (Line Total): 12000 CAD 

 
Please note that the commodity code should be specified if applicable. 
 
 

 
 
After saving the transaction, we can see that the tax amount applied is 1440 CAD. This tax amount 
is calculated only on the product value and not on the freight charges. The reason for the exemption 
of tax on the freight charges is based on the rules configured within ONESOURCE Determination. 
 
Additionally, the tax calculation correlation id for this transaction is - 149_20230531140157. This 
correlation id is used as a reference when analyzing logs and trouble shooting issues. 

Sales Quotation

Customer CUS006
Name Customer-BC
Contact Person

Customer Ref. No.
Local Currency

Contents Logistics Accounting Attachments

Item/Service Type Item
# Item No. Quantity Unit Price Discount % Tax Code Total (LC) Whse

ITM0002 1 $12,000.00 0.00 $12,000.00 WW1

 

  
  

 

 
 

    

  

        

     



 

 
 
The tax amount for each line item will be updated at the line level, indicating the tax applied 
specifically to that item. Additionally, the tax amounts of all the line items will be summarized based 
on the applied tax authority zone levels. These summarized tax amounts will be saved in the "Sales 
Tax and Freight" table, providing a breakdown of taxes by tax authority levels like GST, PST, HST 
and QST.  

Sales Order 

After creating the sales quotation, you can copy the document to a sales order. In the sales order, 
you will not make any changes to the values except for updating the delivery date. Simply click on 
the "Add" button to save the sales order. At this point, the system will send a tax calculation request 
to the TR Tax engine. Once the tax calculation is completed, the system will update the tax amounts 
for each line item, along with the correlation id, and save the document. 
 
The tax amount for each line item will be updated at the line level, indicating the tax applied 
specifically to that item. Additionally, the tax amounts of all the line items will be summarized based 
on the applied tax authority zone levels. This summarized tax information will be saved in the "Sales 
Tax and Freight" table, providing a breakdown of taxes by tax authority levels. 
It is important to note that at this stage, no actual tax will be posted in SAP, as taxes are only 
applicable during the invoice stage. 
 

Sales Quotation
Customer Ker. INo. valla untll 30/06/2023
Local Currency Document Date 31/05/2023

Contents Logistles Accounting Attachments 

Item/Service TypeItem Summary TypeNo Summary
Item No. Quantity Unit PriceDiscount % Total (LC)Whse  Distr. RuleFreight 1Freight 1 (LC) UoM Code COGS Distr. Rule Country/Region of Origin  Blanket Agreement No.Allow Procmnt. Doc.

2000011 1 $ 12,000.00 0.00 > N/A $ 12,000.00 >W1 Manual ÿ

Sales EmployeeNo Sales Employee- Total Before Discount $12,000.00
Owner Discount %
Tax Amount 1,440.00 Sales Tax & Freight $ 1,440.00
Correlation Id 149_20230531140157 Rounding

 
   

   

   

    
           
       

    
   

    
  



 

 

Sales Invoice (A/R Invoice) 

After copying the sales order to an A/R Invoice, click on the "Add" button to save the invoice. At this 
point, the system will once again send a tax calculation request to the TR Tax engine. Once the tax 
calculation is completed, the system will update the tax amounts for each line item, along with the 
correlation id, and save the document. 
 
Once the A/R Invoice is posted, the system will send the tax details to the TR Audit Database for 
reporting, global compliance, reconciliation, and data analysis processes. This process is known as 
the "Commit call".  
 
Similar to previous stages, the tax amount for each line item will be updated at the line level, 
reflecting the tax applied to each specific item. The tax amounts of all the line items will be 
summarized based on the applied tax authority levels, and this breakdown will be saved in the 
"Sales Tax and Freight" table. This provides a comprehensive view of the taxes applied, categorized 
by tax authority levels. 
 

 

Sales Order
Customer CUS006 No. Primary 10
Name Customer - BC Status Open
Contact Person Posting Date 31/05/2023
Customer Ref. No. Delivery Date 31/05/2023
Local Currency Document Date 31/05/2023

Contents Logistics Accounting Attachments

Item/Service TypeItem Summary TypeNo Summary
Item No. QuantityUnit Price  Discount %apoo xe1Total (LC) Whse Distr. RuleUoM Code COGS Distr. RuleCountry/Region of Origin Blanket Agreement No.Allow Procmnt, Doc. Standard Item IdentificationC.

1 $ 12,000.00 0.00ÿN/A $ 12,000.00ÿW1 Manual ÿ ÿ
0.00

Sales EmployeeNo Sales Employee*ÿ Total Before Discount $12,000.00
Owner Discount %
Tax Amount ÿ 1,440.00  Sales Tax & Freight $ 1,440.00
Correlation Id 139_20230531140659 Rounding

xe1
Total $13,440.00

A/R Invoice

Customer CUS006 No. Primary 11
Name Customer - BC Status Canceled
Contact Person Posting Date 31/05/2023
Customer Ref. No. Due Date 31/05/2023
Local Currency Document Date31/05/2023

Contents Logisties Accounting  Attachments

Item/Service TypeItem Summary TypeNo Summary
Item No. Quantity Unit PriceDiscount %apoo xe1Total (LC)Whse  Distr. RuleFreight 1 Freight 1 (LC)Freight 1 Tax...UoM Code COGS Distr. RuleCountry/Region of Origin Blanket Agreement No.5

$ 12,000.00 0.00 > N/A $ 12,000.00ÿ W1 Manual

 Sales EmployeeNo Sales Employee* Total Before Discount $12,000.00
Owner Discount %
Tax Amount 1,440.00 Total Down Payment
Correlation Id 133_20230531140927 Sales Tax & Freight $ 1,440.00

Rounding

 Payment Order Run
xe1
Total $ 13,440.00

 

 

     
    

   
   
   

    

    
              

       
  

 

  
   

   
     
   

 
 

 

     
    

   
   
   

    

    
              

    

    
   

   
    

 
 

 



 

 
 

 

Sample Transaction (Purchase) 
Purchase Quotation 

Here we have taken a Vendor called “V002” with its ship from address as  
• Country – CA 
• State – ON 

 

 
 
The ship To Location is.  

• Country – CA 

SalesTax&Freight

Do Not Display Freight Charges with Zero Amount

Freight Name Remarks Total TaxAmount Distrib.Method Net Amount Base Docu..

1 TR_GST V/Nÿ $0.00 None $600.00
2 TR_PST VNÿ $0.00 None $840.00

$1,440.00

OK Cancel

Purchase Quotation

Vendor >V002
Name ON Business Partner Master Data
Contact Person
Vendor Ref. No. DEMO Code Manual V002 Vendor Local Currency
Local Currency Name ON Account Balance -26,858.25

Primary
ÿ

Group No. 3 Foreign Name Goods Receipt POs 0.00
Group Vendors Purchase Orders 0.00
Currency All Currencies
Federal Tax ID

Contents Logistics

o1 d:45 BC
CANADA General Contact PergonsAddresses Payment RunAccgunting Remarks Att

Pay To Ship To Mser

o1 ÿed Define New Address ID ON

Ship To Address Name 2
NO Address Name 3

Shipping Type Define New Street / PO Box

Ship From ON
Delivery Term City

Zip Code
County
State Ontario
Country/Region Canada
o xe

Set as Default
Street No.

 

 

      

      

      

 

 

 

  
   

 
       
     

 
 

     
    

  
 

  

  
        

   
    

  
  

   

  
  

 
 

  
  

 
 



 

• State – BC 
• Buyer Registration: R425979 

 

 
 
Line Items 

• Product Code – ITM0001 
• Commodity Code  
• Quoted Quantity – 10 
• UOM – Each 
• Unit Price – 1000 CAD 
• Taxable Value (Line Total) – 10000 CAD 

 

 
 
After entering the details and clicking on the calculate button, or trying to add/ save the document, 
the system will calculate the tax. In this example, we found that the tax amount is CAD 1200. After 
saving the transaction, we can see that the tax amount of CAD 1200 is applied to the product value 
according to the TR Tax rule based on the ship-from and ship-to addresses.  

Warehouses - Setup
Warehouse Code W1 Warehouse Name Bd

General Accounting

 Inactive Drgp-Ship

Location  Nettable
Allow Use Tax

Street/PO Box
Street No. Enable Bin Locations
Block
Building/Floor/Room
Zip Code
City
County
Country/Region Canada
State British Columbia
Federal Tax ID R425979
GLN Show Location in Web Browser
Tax Office
Address Name 2
Address Name 3

OK Cancel

Purchase Quotation

Vendor V002
Name ON
Contact Person ÿ

Vendor Ref. No. DEMO
Local Currency
Group No. Primary 3

Contents Logistics Accounting Attachments

Item/Service Type Item
# Item No. Requirad Date Quoted Date Required Qty.Quoted Qty. Unit Price Discount % o xee Total (LC) Whse Distr. Rule

1 ITM0001 16/06/2023 10 10 $1,000.00 0.00 N/A $10,000.00 W1

 

    

  

  

  
 

 
  

 
 

 
 

 
  

  
  

  
 

 
 

 

 

  
  

  

  
 

   

    

 

           

         



 

 

 
 
The tax amount for each line item will be updated at the line level, and the total tax amount for all 
line items will be summarized based on the applied tax authority levels. This information, including 
the breakdown of taxes and freight charges, will be saved in the "Sales Tax and Freight" table for 
further reference and analysis. 

Purchase Order 

After copying the purchase quotation to a purchase order and saving it without any changes except 
for the delivery date, the system will send a tax calculation request to the TR Tax engine. Once the 
calculation is completed, the system will update the tax calculation for each line item and save the 
document with the assigned correlation ID. 
The tax amount for each line item will be updated at the line level, and the total tax amount for all 
line items will be summarized based on the applied tax authority zone levels. This information, along 
with the breakdown of taxes and freight charges, will be saved in the "Sales Tax and Freight" table. 
At this stage, no actual tax will be posted in SAP as taxes are only applicable during invoice 
processing. 
 

Purchase Quotation

Vendor >V002 No. Primary 3
Name ON Status Closed
 Contact Person Posting Date 16/06/2023
Vendor Ref. No. DEMO Valid Until 16/06/2023
Local Currency Document Date 16/06/2023
Group No. Primary ÿ Required Date 16/06/2023

Contents Logistics Accounting Attachments

Item/Service TypeItem Summary TypeNo Summary
Item No. Required DateQuoted Date Required Qty.Quoted Qty. Unit PriceDiscount % apo xe1 Total (LC)Whse Distr. Rule UoM Code Country/Region of Origin  Blanket Agreement No.GST Rate GST A..

16/06/2023 10 10 $ 1,000.00 0.00> N/A $ 10,000.00>W1 Manual 0.05

Buyer No Sales Employee- Total Before Discount $ 10,000.00
Owner Discount %
Tax Amount 1,200.00 Purchase Tax & Freigh > $1,200.00
Correlation Id 540000988_20230616150748  Rounding

xe1
Total Payment Due $ 11,200.00

 

     
    

   
    

   
  

   

    

    
             

         

    
   

    
   

 
 



 

 

Purchase Invoice (A/P Invoice) 

After copying the purchase order to an A/P invoice and saving it without any changes, except for 
clicking on the "Add" button, the system will perform several checks. Firstly, it will verify if the user 
has entered any Vendor Central Tax (VCT) amount. If no VCT amount is entered, the system will 
prompt the user for confirmation. 
 
The purpose of this check is to ensure that the VCT amount is properly entered and considered for 
tax calculation. It helps prevent any errors or omissions in the VCT amount, ensuring accurate tax 
determination for the invoice. 
 

 
If the user forgets to enter the Vendor Central Tax (VCT) amount, they need to click on the "Cancel" 
button. However, if there is no tax charged by the vendor, the user can click on "OK" to proceed. In 
this case, the system will send a tax calculation request to the ONESOURCE Determination. Once 
the calculation is completed, the system will update the tax calculations along with the correlation ID. 
 
The VCT accrual method will be determined based on the VCT configuration and the given VCT 
amount. The accrual method can be one of the following: 
 

• Accrue Variance 

Purchase Order

Vendor >V002 No. Primary 10
Name ON Status Closed
Contact Person Posting Date 16/06/2023
Vendor Ref. No. DEMO  Delivery Date16/06/2023
Local Currency Document Date 16/06/2023

Contents Logistics Accounting Attachments

Item/Service TypeItem Summary TypeNo Summary
Item No. Quantity  Unit Price Discount %apoo xe Total (LC) Whse Distr. RuleUoM Code Country/Region of Origin Blanket Agreement No.Standard Item Identification Commodity ClassficationGST Rate G...

10 $ 1,000.00 0.00 > N/A $10,000.00ÿ w1 Manual 0.05

Buyer No Sales Employee* Total Before Discount $ 10,000.00
Owner Discount %
Tax Amount 1,200.00 Purchase Tax & Freigh $ 1,200.00
Correlation Id 142_20230616150844 Rounding

Total Payment Due $11,200.00

System Message X

Vendor TaxAmountiszero,Do youwant toproceed ?

Ok Cancel

 

     
    

   
    
   

    

    
           

       

   
   

  
   

 

  

  

 



 

• Accrue Total Tax 

• Pay VCT No Accrual 

• Hold Payment 

If the determination results in "Accrue Variance" or "Accrue Total Tax" as the accrual method, there 
will be a separate line item in the Freight setup called "TR_AccrueVariance" to determine the accrual 
amount. This line item applies only if the accrual method is Accrue Variance or Accrue Total Tax. 
 
If the accrual method is "Hold Payment," the system will not allow the user to post the transaction 
until they modify the details, or the system receives a different accrual method. In this scenario, the 
system will allow the user to save the document in Draft if desired, and they can use the draft 
document later. 
 
If the accrual method is "Pay_VCT_No_Accrual," the system will update the tax amount as per the 
VCT and system will book the transaction with VCT amount not the determination calculated tax. In 
this case, the user will pay the supplier the same amount as the tax charged by the supplier. 
 
After the A/P Invoice is posted, the system will send the tax details to the TR Audit Database for 
reporting, global compliance, reconciliation, and data analysis processes. This process is known as 
the "Commit call." At this stage, the actual tax amount is booked in the database, and the tax 
information will be saved in the TR audit database. 
 
The tax amount for the line items will be updated at the line level, ensuring that each line reflects the 
appropriate tax calculation. Additionally, the tax amount for all line items will be summarized based 
on the applied tax authority zone levels. This summary will be saved in the "Purchase Tax and 
Freight" table, providing a breakdown of the tax amounts based on different tax authority levels. 
 



 

 
 
After the A/P Invoice is posted, the system will create the necessary accounting entries for the 
transaction. The tax amount will be included in these accounting postings. Specifically, the tax 
amount will be recorded in a clearing account. 
 
During the A/P Invoice posting, all Tax GL account will be posted along with PST Tax GL account 
will be debited with the tax amount. This reflects the tax input of the company. Subsequently, when 
the Landed Cost is calculated and posted, the PST Tax account will be credited with the same tax 
amount. This ensures that the tax amount is properly allocated and accounted for in both the A/P 
Invoice and the Landed Cost. 
 
By using a PST Tax account, the system maintains the accurate representation of the tax amount as 
cost and ensures proper reconciliation between the A/P Invoice and the Landed Cost. 
 
 
Journal Entry in A/P Invoice 
 

A/P Invoice
Vendor >V002 No. Primary 14
Name ON Status Open
Contact Person Posting Date 16/06/2023
Vendor Ref. No. DEMO Due Date 16/06/2023
Local Currencyÿ Document Date 16/06/2023

Contents Logistics Accounting  Attachments
Item/Service TypeItem ÿ Summary TypeNo Summary

 Item No. QuantityUnit Price Discount % apo xe1 Total (LC)Whse D...
ITM0001 10 $ 1,000.00 0.00 => N/A $10,000.00ÿ W1

Buyer No Sales Employee- Total Before Discount $10,000.00
Owner Discount %
Tax Amount 1,200.00 Total Down Payment
Correlation Id 141_20230616161456Purchase Tax & Freigh $ 1,250.00
Vendor Tax Amount 1,250.00  Roynding 

 Payment Order Run
xe1
Total Payment Due $ 11,250.00

 

     
    

   
    

 
   

    
     

       
      

   
   

   
   

  

 
 

 



 

 
 
Journal Entry in Landed Cost Document 
 

 
 
 
 

Journal Entry
Series Number Posting Date Due Date Doc. Date Remarks
Primary 79 23/06/2023 23/06/2023 23/06/2023 A/P Invoices - V002
Origin Origin No. Trans. No. Template Type Template

ÿPU 231800004 79
Trans. Code Ref. 1 Ref. 2 Ref. 3

231800004

Blanket Agreement

Contents Attachments
Expand Editing Mode

# G/L Acct/Bp G/L Acct/BP Name 1.9a0 Rem... Tax Posting Accountx1o
1 ÿ V002 ON $1,135.00

2 12300000 Taxes Rreceivable Gst/Hst/Qst $0.00
E 13500000 Inventories of Finished Goods $ 1,000.00
4 24110000 Gst Tax Reclamable $ 56.25
5 24280000 Pst Tax Payable - Alberta $78.75

$ 1,135.00 $ 1,135.00

Journal Entry

Series Number Posting Date Due Date Doc. Date Remarks
Primary 80 23/06/2023 23/06/2023 23/06/2023 Landed Costs 15
Origin Origin No. 'ON 'Se1 Template Type Template Project

IF 15 80
Trans. Code Ref. 1 Ref. 2 Ref. 3

15

Blanket Agreement

Contents Attachments
Expand Editing Mode

G/L Acct/BP ...G/L Acct/BP Name 19a0 Rem...Tax Posting AccountTax Codesung xel
1 ÿ 13500000 Inventories of Finished Goods $ 78.75
2 24280000 Pst Tax Payable - Alberta

$ 78.75 $ 78.75

 

      
      

     
   

    
 

 

  
 

       
     
    
    
    
    

 

 

      
      

      
   

    
 

 

  

 

     

     

   

 



 

After the A/P Invoice is posted, the system will automatically calculate and book the landed cost 
associated with the PST tax amount. This is done to allocate the tax expense to the stock items, 
as there is no input tax credit in the USA. 
 
The landed cost will be calculated based on the tax applicable for each line item in the A/P 
Invoice. The system will determine the appropriate tax rates and factors for each item and 
calculate the corresponding landed cost. 
 
The relationship between the A/P Invoice and the landed cost will be automatically managed by 
the system. This ensures that the tax amount is accurately allocated to the stock items and 
reflected in the inventory valuation. 
 
By booking the landed cost, the system accounts for the tax expense and incorporates it into the 
overall cost of the stock items. This provides a comprehensive view of the true cost of the 
inventory, taking into account the applicable taxes. 
 

 
 

Relationship Map

PurchaseOrderBusinessPartners

V0001

Vendor 1
01/25/23

$328.50

Purchase Quotation A/P Invoice Landed Costs

36
49 01/25/23

01/25/23 01/25/23 $ 324.75

$ 328.50 $ 320.00

MarketingDocument:DocumentTree

 

  

 

 
 

 

   
 

  
   

  



 

 
 

 

Landed Costs

Vendor >v002 ON Number 15

Broker Series Primary
Posting Date 23/06/2023

$ Closed Document Due Date 23/06/2023
Reference

 Items Costs Vendors Details General Attachments
Item No. Qty Base Doc. Price Base Doc. Value Proj. Cust. Customs Value Expendi... Z

1 $ 1,000.00 $ 1,000.00 $ 0.00 $ 0.00 $7

Projected Customs Total Freight Charges $ 78.75 Before Tax $ 1,078.75
Actual Customs $0.00 Amount to Balance $ 0.00 Tax 1 $ 0.00
Customs Date 23/06/2023 Z xe $0.00
 Customs Affects Inventory Total $ 1,078.75

Remarks
Based On A/P Invoices 231800004,

OK Cancel Copy From

Journal Entry

Series Number Posting Date Due Date Doc. Date Remarks
Primary 80 23/06/2023 23/06/2023 23/06/2023 Landed Costs 15
Origin Origin No. 'ON 'Se1 Template Type Template Project

IF 15 80
Trans. Code Ref. 1 Ref. 2 Ref. 3

15

Blanket Agreement

Contents Attachments
Expand Editing Mode

G/L Acct/BP ...G/L Acct/BP Name 19a0 Rem...Tax Posting AccountTax Codesung xel
1 ÿ 13500000 Inventories of Finished Goods $ 78.75
2 24280000 Pst Tax Payable - Alberta

$ 78.75 $ 78.75
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